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Abstract 

The processor allocation in an n-dimensional hypercube 

multiprocessor using buddy strategy, gray code strategy, and a new 

strategy is implemented on Macintosh. Our implementations show that 

when processor relinquishment is not considered ( i.e. static 

allocation ), all these strategies are optimal in the sense that each 

incoming request sequence is always assigned to a minimal subcube. 

Our implementations also show that the gray code strategy 

outperforms the buddy strategy in detecting the availability of 

subcubes, and furthermore, when some faulty processors are 

considered or processors are allocated dynamically, the new strategy 

does better than the buddy strategy or gray code strategy in subcube 

recognition. 
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1. Introduction 

This project implements the processor allocation in an N-cube 

multiprocessor using three strategies, i.e. buddy strategy, gray code 

strategy[4], and the new strategy proposed by AI-Dhelann and Bose[1 ]. 

What is an hypercube? An hypercube is a network of loosely 

coupled processors connected in such a way that two processors are 

linked if and only if their binary representation differ in exactly one 

bit position, i.e. the indices of neighboring processors differ by a 

power of 2. 

A n-dimensional hypercube, denoted as n-cube or On, is a 

hypercube with 2n processors and is defined recursively as: A 

0-dimensional hypercube, Q0 , is a single processor, and an 

n-dimensional hypercube is two (n-1 )-dimensional hypercube with 

links between corresponding processors in each of them. Fig.1.1 and 

Fig.1.2 show a 0 4 and a 0 5, hypercube respectively. 

Fig.1.1 4-dimensional hypercube, ~ 
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Fig.1.2 5-dimensional hypercube, Q5 

A task arriving at a hypercube multiprocessor --- this is called 

an "incoming request" --- can be specified in graph form and must be 

assigned "optimally"(in some sense) to a subcube in the 

multiprocessor for execution. Upon completion of execution, the 

subcube used for the task must be released(relinquished or 

deallocated) for later use. Efficient allocation and/or deallocation of 

node processors in a hypercube multiprocessor is a key to its 

performance and utilization. Each incoming task to an n-cube 

multiprocessor is described by a graph, in which each node denotes a 

module of the task and each link represents inter-module 

communication. Each module must be assigned to a subcube so as to 

preserve node adjacencies in the associated task graph. Thus, 

processor allocation in an n-cube multiprocessor consists of two 
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sequential steps : 

1) Determination of the dimension of the subcube required to 

accommodate all the modules of each incoming task and allocation 

of modules of the task to nodes within the subcube. 

2) Recognizing and locating each subcube that can accommodate the 

incoming task. 

In this project, we are only concerned the second step in which 

several processor allocation strategies are used to implement the 

recognition and location of the subcubes in the n-cube system, 

assuming that all the incoming task graphs have already been 

embedded into subcubes[S]. 

2. Processor Allocation Strategies 

In an N-cube multiprocessor, processors must be allocated to 

incoming tasks in a way that will maximize the processors utilization 

and minimize the system fragmentation. In order to achieve this goal, 

it is necessary to detect the availability of a subcube of required size 

and merge the released small cubes to form a larger ones. Following 

are the processor allocation strategies to be used in implementation 

later. 

• Algorithm 1 ( Buddy System Strategy ) 

Processor Allocation: 

Step1 .Set k to the dimension of a subcube required to 

accommodate the request. 

Step2. Determine the least integer a, O ::; a::; 2n-k - 1, such that 
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all ,8th allocation bits, a2k :s; ~ :s; ( a+ 1) 2k -1, are O's. Set all 

these bits to 1 's. 

Step3.Allocate processors with addresses Bn(~) to the request, 

where 

a2k :s; ~ :s; (a+1)2k -1. 

Processor Relinquishment: 

Reset every pth allocation bit to 0, where Bn(P) is used in the 

subcube released. 

Note: Bn(P) above is the binary representation of an integer p with n 

bits. e.g. B3(1 )=001, B4(3)=0011. 

• Algorithm 2 ( Gray Code Strategy ) 

Processor Allocation: 

Step1 .Set k to the dimension of a subcube required to 

accommodate the request. 

Step2.Determine the least integer a, O :s; a :s; 2n-k+1 - 1, such that 

all (~ mod 2n)th allocation bits are O's, where a2k- 1 :s; ~ :s; 

(a+2) 2k-1 - 1. Set all these bits to 1 's. 

Step3.Allocate nodes with addresses Gn(b mod 2n) to the 

request, where 

a2k-1 :s; ~ :s; (a+2)2k-1 - 1. 

Processor Relinquishment: 

Reset every pth allocation bit to 0, where Gn(P) is used in the 

subcube released. 

Note: Gn(m) is the BRGC (Binary Reflected Gray Code) representation 

of m. e.g. G4 (3) = 0010. Following formula can be used to translate the 
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gray code to its corresponding binary representation and vice versa: 

gi = bi xor bi+1 i -::t; n 

Note: 

gn = bn 

• Algorithm 3 ( New Strategy ) 

Processor Allocation: 

Step1 .Set k to the dimension of a subcube required to 

accommodate the request. 

Step2.Determine the least integer a, O ~a~ 2n-k+1 - 1, such that 

B n-k+ 1 (a) is free and it has a pth, O ~ p ~ n-k, partner 

BPn-k-1 (a) which is also free. Take p as small as possible. 

Step3.Allocate these processors to the request, and set their 

allocation bits to 1. 

Processor Relinquishment: 

Reset the allocation bits of all the processors that correspond to 

the descendants of the nodes Bn-k+1 (a) and BPn-k-1 (a) to 0. 

1) The ath partner of ak_1ak_2 ... aa+1aaaa_1 ... a0 for any O ~a~ k-1 

is defined as 

ak-1 ak-2 .. . aa+ 11 aa-1 .. ,ao 

undefined 

if aa = 0 

if aa = 1 

We denote the pth partner of Bk(i) as 8Pk(i). 

2) For any integer a, 0 ~ a ~ 2n-k+1 - 1, the node Bn-k+1 (a) is free if 

and only if all of its descendants are free. e.g. for n = 4 and k = 2, 
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the node 000 is free if and only if the processors 0000 and 0001 are 

free. 

3. User Interface 

Fig.3.1 shows the screen for the main menu for the hypercube 

application environment. 

/ • File Edit Strategies Layout 

Fig.3.1 The main menu of the Hypercube application 

3.1. Apple Menu (Fig.3 .2) 

File Edit Strategies Layout 

About Hypercube ... 

Calculator 

Chooser 

Control Panel 

Key Caps 

Scrapbook 

Fig.3.2 Apple menu 
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• About Hypercube ... 

This item gives an About dialog (Fig .3.3) that displays 

author information, project information, and version information. The 

main purpose is to provide user quick information about the 

application. 

• Desk Accessories 

The other items include desk accessories which depend on 

your Macintosh system file. 

♦ 

.. 
• 

• 
+ 

• 

♦ 

♦ 

. . . . 
. . .. 
. HVPERcub~, -Yersior1_ 1.0 

. . •· by 

JINVUE Ll ·U 

+ 

♦ 

• ♦ • 

Depat~me~t of ~o~~·uter Sc~ence ·. 

_; _·Qrego~ Sta.te· Ura_iversit_y 
. . 

• Corva.~.Hs,- Oregon 
.. • .. 

+ . 

Fig.3.3 About dialog 
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3.2 File Menu (Fig.3.4) 

• 111 r:::11 Edit Strategies Loyout 
.... 

New ... XN 
Open ... XO 
CIOH~ 

....................................................... 

Saue 
Saue Rs ... XS 

••• •••• •• •.,• •• •• ••• •• •• ••• •••• ••.,• • n •••• • •• • •• •••• •• 

Quit XQ 

Fig.3.4 File menu 

• New 

This command is intended to set up a diagram window 

with a hypercube in it whose size is given by users. 

• Open 

This command is used to load an already existing diagram 

in memory. 

• Close 

This command is used for closing any window that appears 

on the screen. 

• Save 

This command is used to save the diagram with its 

existing name. 
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• Save As ... 

This command is used for saving the diagram with another 

name. 

• Quit 

This command as usual is used for quiting the application. 

3.3 Edit Menu (Fig.3.5) 

• File 1:r.11■ Strategies Layout " 
Allocate ... XA 

Faulty ... XF 

Show ► 
Release ► 

. Fig.3.5 Edit menu 

• Allocate ... 

This command allocates the available processors to the 

incoming task according to some strategy chosen 

previously by users. 

• Faulty ... 

This command allows users to give the faulty processors. 
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• Show 

This is a submenu. It includes all the existing tasks that 

can be showed. 

• Release 

This is a submenu. It includes all the existing tasks that 

can be released. 

3.4 Show Submenu 

This menu allows users to show whatever the existing task he 

wants (Fig.3.6). 

a File Strategies Layout 

te... 3€H 

Tosk_l 
l<l~k .... 2 

Tosk_3 
Tosk_4 
Tosk_5 

l<l~k .... 6 

Tosk_7 
Tosk_8 

Fig.3.6 Show subrnenu 

Here we use the new menu feature: hierarchical menu, which is 
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used for lists of related items, such as tasks, to keep them simplicity 

and clarity. A hierarchical menu is a logical extension of the current 

menu metaphor: another dimension is added to a menu, so that a menu 

item can be the title of a submenu. When the user drags the pointer 

through a hierarchical menu item, a submenu appears after a brief 

delay. 

Hierarchical menu items have an indicator ( a small black 

triangle pointing to the right, to indicate "more") at the edge of the 

menu, as illustrated in Fig.3.6 and Fig.3.7. 

3.5 Release Submenu 

This command allows users to release whatever the existing 

task he wants (Fig.3.7). Once a task is released, it can not be showed 

or released again and the correponding menu item is dimmed( as is 

Task_2 and Task_6 in Fig.3.7). 
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S File Strategies Layout 

Rllocate... XR 

Faulty... X F 

Show ► 

Release ► 
------. 

Task_l 

l<l~k .... 2 

Task_3 

Task_4 

Task_5 

l<l~k. ... 6 

Task_7 

Task_8 

Fig.3.7 Release submenu 

3.6 Strategies Menu (Fig.3 .8) 

This menu consists of three menu items representing three 

strategies which can be chosen by users. 

Ii File Edit Strategies Layout 

✓ Buddy 

Gray_Code 

New Strategy 

XI 

3€2 

3€3 

Fig.3.8 Strategies menu 
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3.7 Layout Menu (Fig.3.9) 

• File Edit Strategies 

Reduce To Fit 

TeHt 

Fig.3.9 Layout menu 

• Reduce To Fit 

This command is used for viewing entire hypercube in 

reduced size. 

• Text 

This command lists all the existing tasks and the faulty 

processors in binary representation in a text window. 

4. Implementation and Implementation Results 

4.1. Implementation 

The user can create a new hypercube by selecting the New 

command in File menu. First, a dialog will come up allowing users to 

give the hypercube order (Fig.4.1 ). 
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Please enter the hypercube order: 

I..___ 4 ____.I · 

• OK II [ . CANCEL 

Fig.4.1 Enter hypercube order 

After we give the hypercube order and click OK button, a diagram 

window with hypercube in it will be set up (Fig.4.2). 
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Hypercube 

: •:•:• 

111111 
:-:-: -

lilill 
mm 

.. ................................................. 
. ....... ... .. . ..... ....... ... ... . .. . .. . .. ... . .. ... . 

Fig.4.2 4-dimensional hypercube, ~ 

Here each circle stands for a processor and processors connected 

by line or arc are neighbors. In a two dimensional plane, to draw an n 

dimension hypercube will result in many line or arc crosses among 

node connections. In order to reduce the crosses, we design a very 

special way to arrange the processor location. 

The next step is to allocate the processors to the incoming task. 

This can be achieved by choosing the Allocate command in Edit menu. 

A dialog will pop up allowing users to enter the task size or subcube 

order (Fig .4.3). But remember to pick up the strategy you want before 

you allocate processors. The default strategy will be the buddy 
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strategy when a new hypercube is created. After you enter the task 

size and click OK button, those processors allocated to this task will 

be shaded-in (Fig.4.4). 

Please enter the task size: 

II OK B CRNCEL 

Fig.4.3 Enter task size 

-16-
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Hypercube 

Fig.4.4 Processor allocation with requests 11 = Q2, 12 = Q1 using Buddy Strategy 

The tasks are given sequentially in Show and Release submenu. 

A user can display whatever task he wants by selecting the task in 

Show submenu. Those processors or nodes belonging to this task we 

choose will be blinking until the mouse is pressed down. Once the task 

is finished, these processors belonging to the task may be 

relingquished. Release submenu can do this by choosing the task in 

the Release submenu. The processors belonging to the task we choose 

will be blanked after release and can be allocated to incoming task 

later. 

This application also provides users an opportunity to give some 

faulty processors. The faulty processor could be assumed by users 
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giving the processor number in a dialog which will be brough up when 

selecting Faulty command in Edit menu. The faulty processor is 

represented by a black node and it can be either the busy processor or 

the idle processor (Fig.4.5). But the faulty processor can not be 

recovered once it is assumed fault. 

Hypercube 

111111 

111111 
:,:,:, 

... .. .. .. ..... .... .... ...... . ........ .. ........ .. . . . . 
........ ... ... ...... ........... .. .... ... -... ··········· 

Fig.4.5 Hypercube with a faulty node 15 

An entire hypercube can be viewed by the Redoce To Fit menu 

choice available in the Layout menu (Fig.4.6). This is useful especially 

when the hypercube order is large and the user can not see the entire 

hypercube on the screen in the normal size. The application also 

provides the user with a text window that shows all the existing 
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tasks with the processors represented in binary and all faulty 

processors (Fig.4.7). The text window can be opened by selecting the 

text item in the layout menu and can be hidden by clicking the close 

box. The contens of the text window is keeping updated automatically 

every time the diagram is changed. 

l ...... ,.--H"l --. ~ 
I, 

, , ,; 

~ 
.,.. -H 

u ....._ -
1,,- = = r-, .... ~ ,. '-~ \ "\i \, "' .I r...,lJ 
--....::::- ~ 

[( OK )] 

Fig.4.6 Reduced view of the 5-Cube 
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Hypercube task assignment table ~ 

TASK_ 1 ( buddy ) 

0000 0001 0010 0011 

T ASK_2 ( buddy ) 

0100 0101 

Faulty Processors 

1 1 1 1 

Fig.4.7 Text window corresponding to Fig.4.5 

4.2. Implementation Results 

i) Static Allocation Test 

A test of the static processor allocation using three strategies 

in a 4-cube multiprocessor is given in Fig.4.8 . Following are the 

incoming request numbers li's and their sizes Oi 's: 

I 1 = Oo , 12 = 03 , 13 = 02 , 14 = 01 , Is = Oo . 

-20-



l 
n 
n 
n 
n 
0 
I 
l 
ti 
r J 

d 
H 
j 

u 
Li 

J 

u 
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□ TeHt 

Hypercube task: assignment table IQ 

TASK_ 1 ( buddy ) 

0000 

T ASK_2 ( buddy ) 

1 000 1001 101 0 10 1 1 1 1 00 

1101 1110 1111 

TASK_3 ( buddy ) 

0100 0101 0110 0111 

T ASK_4 ( buddy ) 

0010 0011 

T ASK_S ( buddy ) 

0001 

No Faulty Processors 

Fig.4.8.a Processor allocation using buddy system 
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□ TeHt 

Hypercube tosk assignment toble -

TASK_ 1 ( grey_code ) 

0000 

TASK_2 ( grey_code ) 
0 1 1 0 0 1 11 0 10 1 0 100 1 100 

1101 1111 1110 

TASK_3 ( grey_code ) 
1010 1011 100 1 1 000 

TASK_4 ( grey_code ) 

000 1 0011 

TASK_S ( grey_code ) 
0010 

No Foul ty Processors 

111111 

!!!ill 

Fig.4.8.b Processor allocation using gray code system 
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□ TeHt 

Hypercube t~sk assignment table -

TASK_ 1 ( new stretegy ) 
0000 

TASK_2 ( new stretegy ) 
0100 0101 0110 0111 1100 

1101 1110 1111 

TASK_3 ( new stretegy ) 
00 1 0 00 1 1 10 1 0 101 1 

TASK_4 ( new stretegy ) 
0001 1001 

TASK_S ( new stretegy ) 
1000 

No Faulty Processors 

TI 
rnrn 

Fig.4.8.c Processor allocation using new strategy 

The results show that all these three strategies are optimal in the 

sense that each incoming request sequence is always assigned to a 

minimal subcube, and furthermore, from Fig.4.8.c we can see that the 

new strategy compacts things to the left which result in less system 
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fragmentation; thus the new strategy recognizes more subcubes. 

ii) Dynamic Allocation Test 

Following are a series of requests: 

I 1 = 02 ' 12 = 02 ' 13 = 02 ' 14 = 02 

After allocation, release tasks 11 and 13 . Now try allocating 

processors to incoming task 15 = 0 3 . A stop alert dialog will suggest 

that using other strategies may satisfy this (Fig.4.9). 

Our results 

request, but 

There is no way to assign the task. 

Try other strategies ! 

OK )] 

Fig.4.9 Stop alert dialog 

show that the buddy strategy will not satisfy this 

gray code strategy and new strategy will satisfy this. 

This means that gray code strategy and new strategy outperform the 

buddy strategy in detecting the availability of subcube. 
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Another series of requets is 

11 = 01 ' 12 = 02 ' 13 = 01 ' 14 = 03 

After allocation, release tasks 11 , 13 and reallocate the processors 

to in coming request 15 = 0 2 , then both buddy strategy and gray code 

strategy will not be satisfied. But the new strategy will satisfy this 

which means that the new strategy outperforms both buddy strategy 

and gray code strategy. 

iii) Fault Tolerance 

In a 4-cube multiprocessor with the processors 

0000,0001, 1000, and 1001 faulty, consider the requests { 11 = 0 3 , 12 

= 0 2 }. Our result shows that neither buddy system allocation nor 

gray code strategy will be able to satisfy this. But the new strategy 

will satisfy this (Fig.4.10). This means that when some faulty 

processors are cosidered or processors are allocated dynamically the 

new strategy does better than buddy strategy or gray code strategy. 
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Hypercube TeHt 

Hypercube task assignment 

TASK_ 1 ( new strategy ) 

0100 0101 0110 0111 

1101 1110 1111 

TASK_2 ( new strategy ) 

00 1 0 00 1 1 1010 101 1 

Faulty Processors 

0000 000 1 1000 1001 

Fig.4.10 Processor allocation using new strategy with processors 0, 1, 8, 9 faulty 

5. Summary 

We have presented the design and implementation of the 

processor allocation in an n-cube multiprocessor using several 

processor allocation strategies on Macintosh microcomputer. We 

design an easy way to draw the n-dimension hypercube in the 

2-dimension plane and users can easily simulate the processor 

allocation in an n-cube multiprocessor using some processor 

allocation strategy. A text window is also provided for users to look 

at the task assignment textually. 
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